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Flux QuickStart Guide

Introduction

This guide will take you through the process of creating, designing, and editing a web site step-by-
step using Flux. The goal is to create a page like the one pictured below.

You will notice that some of the pages have a shaded bar at the top, these pages are not part of
the guide, and are simply for further information.

You can also see the same site be created in a screencast here, although the process is slightly

different.

http://www.theescapers.com/screencast

Flux is a very advanced and powerful application, and if you’ve never used it before, or even if you

have, The Escapers recommends you follow this guide to get the best out of Flux.

Thanks for trying Flux!

The Escapers Team
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Create the Project

Step 1

Before we can create a web page in Flux, we must first create a Project.

To create a Project from scratch, choose New from the File menu.

Edit f

® Flux G Page Arrange

New with Template...
New Page... {+ 3N
New Folder...

New Stylesheet...

Step 2

You will be presented with a Save sheet.

Choose a location for your new project, and type in a name for it, and press Save

Untitled

Save As: [MySite{

(< »] (323 h=d m) (@@ Documents

N | Date Modified

« CV.mp4 19/05/2008
(] iWeb Stuff 22/04/2010
— « Jen Doctors.mov 06/10/2007
Movies | Jen.dvdproj 08/05/2009
J3 music @ | wce2zip 02/12/2009
(@i Pictures « OutcastsTrimmed.mov 20/05/2008

¥ SEARC Y| (3 Parallels 30/03/2010

ﬁ Applications 2
5 Downloads

The location chosen here will be the 'root’ folder of your website, a
normal directory that Flux will put your pages and other assets, you
can call this folder anything you like i.e. "My LolCat Website"

Project Type | Standard Website ‘-ﬂ

L3
[ Hide extension New Folder m

VA

Step 3

Flux will offer to create a new page and a new CSS file to help get you started. If you are just

starting out in web design, and do not fully understand the relationship between CSS and HTML

files, press Yes
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Do you want to create an index.html file, a
main.css file and an 'images’ folder to get
you started?

You can create these files manually later if you

prefer.
(T No ) GYes)

A brand new site has been created, ready to use.

Jun 01 2010 13:33:16

index.html
340b, Jun 01 2010 13:33:16

main.css
11b, Jun 01 2010 13:33:16

Remember, Flux projects are simply folders, so you can use any existing website folder, it doesn’t

need to have been created by Flux.
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Open the page for editing

Step 1

Double-click the index.html file, this will open the file in Flux’s Page Designer

em== 8 © [, @ A #H

lew Publish Site New Page New Stylesheet New Folder Packages Delete

| — = site |

images
‘ Jun 01 2010 13:33:16

index.html|
‘- 340b, Jun 01 2010 13:32:16

HTML

| main.css
11b, Jun 01 2010 13:33:16
css

Step 2
The Page Designer will open, displaying an empty page, and the CSS styles list has a single entry.
800 o] Page Editor - MySite/index.htm| =
= ksl Preview Live Preview v
index.html
STYLES | NAVIGATOR | = [ counm:lsvl FORMS v| MEDIA v TEXT v Misc v PACKAGES v] i oA
© main.css
3
oo
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The Page Designer

All page editing and designing takes place in the Page Designer, which has a few distinct sections

you need to be aware of.

Design Area

The area highlighted in red in the image below is the Design area, this is probably the area you will

spend most of your time in Flux.

|4] Page Editor - MySite/index.htm|

index.html

STYLES | NAVIGATOR ;| = [ cou'rAm:usv] v|

main.css [ Goad
° @3
.myswle

Frames Padding

The Design area has two toolbars, one at the top, and one at the bottom.

The top toolbar has two purposes, the buttons on the left of the toolbar are to create new
elements on the page, and the buttons on the right of the toolbar toggle between Movement mode
and Text mode, to move objects around on the page, or adjust their size, you should use Movement

mode, and to edit text, switch to Text mode.

[ CONTAINERS v FORMS v MEDIA v TEXT v MISC v PACKAGES V] i/_ Aa

I
|<_
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The toolbar at the bottom of the design area is used to toggle various display options, these
options have no effect on the structure of your page, but they may make your life a little easier.
For example, if you want to visually adjust the Padding of an object, you’ll want to make sure you
have the Padding option selected, as you will then be able to see, and change the padding of an
object by dragging the handles on the element. When the Padding option is turned off, you will
not be able to see the padding of the object, or change it. The more options you turn off, the less

cluttered your page will appear.

| Foames L padding L Margns L seans L Towens 1 meavions 1 ced SEEECETT
e — == = G

It's important to remember that these options will never affect the actual page you are working on,

just how it appears in Flux’s Page Designer.

CSS Area

The CSS Area is on the left side of the Page Designer, it’s a list of the CSS files that are linked to
your page, and the CSS Rules within them.

index.html
pg i = CONTAINERS ¥ FORMS v‘ MEDIA v TEXT v Misc v| PACKAGES v] | S
© main.css ‘ S0y
|
]
I
5
\
i |
[_padding L Margine L spans L Tokens L elations X cra T wasters ] (1008 ) )
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Adding Assets to your Project

Most of the assets in your project will be images, but the following instructions will also work for

MP3s, Quicktime movies, fonts, and any other type of file you want to include in your project.

Method 1

You can easily add files to your project using the Finder, simply drag assets from anywhere on your

Mac, to your project folder (blue arrow).

The Flux site manager will update automatically.

] MySite
0fom | |~ =~ Q
A Name 4 Date Modified Size
» (] images Today, 13:33 L
[¢] index.ht Today, 13:33 4 KB
a £s5 main.css Today, 13:33 4 KB
¥ DEVICES e
2P I iDisk 2.png
L E Spare
| test =
E Tiger
Method 2

You can simply drag files from the Finder to Flux’s Site Manager, note that it’s important to

drag the files to the title of the folder you want to put the files in, as shown by the red arrow in

the image below.

s 3 ) - o N
o4 @ » @ H ¥ XSO CEL i
Publish Site  New Page New Stylesheet New Folder i Packages Delete Effects Refresh Help Find
Site.
images
Jun 01 2010 13:33:16
index.html
340b, jun 01 2010 13:33:16
X selueew
main.css NAME

£ ipisl

| test

¥ PLACES
E Desl
ﬁ mt

¥ DEVICES
}3 Spare

| Tiger

» SHARED

f\; Applications

W Rawmlaade

k

»

ktop

images

Ll

(™| imag;s

(] images

== hook_now_hover.png
== book_now.png

O flower.ipg

[E] wallpaper.jpeg
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Summary

Both of the above methods will have the same result, the images will now be in your project, this

means that Flux can ‘see’ them, and they can be used in your pages.

images
Jun O 2010 14:33:30

index.html|
340b, Jun 01 2010 13:33:16

main.css
11b, Jun 01 2010 13:33:16

images
book_now.png

1k, Jun O1 2010 14:33:29
138x35

book_now_hover.png
2k, Jun 01 2010 14:33:29
138x35

flower.jpg

131k, jun 01 2010 14:33:29
500x386

wallpaper.jpeg
72k, Jun 01 2010 14:33:30
292x350

X Sslowew

NAME
flower.jpg

SIZE
131k

DATE
Jun 01 2010 14:33:29

DIMENSIONS
500x386




e —
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The Site Manager

The Site Manager is where you can view the structure of your site, open pages for editing,

import assets, and publish your site.

806 [ Site Manager - HotelEscape

oo g
oo

m

images
images book_now.png

Jun 01 2010 14:33:40 - 1k, Jun O1 2010 14:33:29

138x35

index.html| book_now_hover.png
1k, May 27 2010 11:03:42 2k, jun 01 2010 14:33:29
138x35

flower.jpg X 8ssouweew

131k, Jun 01 2010 14:33:29
main. sogese NAME
flower.jpg

1k, May 27 2010 11:03:4

wallpaper.jpeg

72k, Jun 01 2010 14:33:30
292x350 SIZE
131k

DATE
Jun 01 2010 14:33:29

DIMENSIONS
500x386

In the image above, the red arrow points out a web page, it has a thumbnail to aid quick
identification, to edit the page, simply double-click it.

The blue arrows point out a folder, the left most blue arrow is the folder, and the right blue arrow
is the contents of the folder.

The orange arrow points to an image file, you can double-click images to open them in the default

application.

To copy a file from the Finder, simply drag it to the title of the folder in the Site Manager.

10
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Configuring the body element

The body element controls the background of your page, we want our new web page to have a nice
image as background, so we need to setup the body to do this.
It’s possible to configure the body using an external style, or inline, it’s generally considered to be

good practice to use an external style, so that’s what we will do now.

Step 1

The first thing we need to do, is to create the body style.

o A W | = (5.4

At the moment, our page has the main.css file linked to it,
Media Inspector Actions & Widgets Snippets M

it’s in this file we will create our body style. -
index.html|

Since we only have one CSS file linked, you don’t need to STYLES

select it specifically, but if you had more than one CSS
file, you would need to select the file you wanted to

create the style in.

Step 2 ‘
P Lo | | g & i
Media Inspector Actions & Widgets Snippets Master Ele
Press the small ‘+’ button at the bottom of the styles list to reveal a || mectw |
. STYLES | = | conta
pop-up menu, in the Override Style submenu, choose body. - —
o ey ]
This will create a brand new CSS style (or rule) called ‘body’ T
The name of the style is very important, it must be called ‘body’, or
it will not work. BLOCKS
There are other ways to link a style to a particular element on the
img
page, but for now, we will use this method, often called the override B
method. i
ha
hs
hé
ul
ol
Step 3 d
SPANS
Now we have created the new CSS rule, we need to set it up to :?f’;,,ym
b
display a background image. So make sure the style we just created g
is selected. @
del
You may also have noticed that a little dot has appeared to the right ™
of the CSS filename, this means the CSS file has been modified, but CEViESiRETs ko
li
is unsaved, so now is a good time to save. ; Ad Embedasd Sweshest | 42

span
+ RULES strong

Press Command-S to save, this will save modified CSS files in New Style sub

New Comment sup ;
addition to the page itself. owrisese > I8

P udo asses u |
CSS Rules > var yri

11



index.html

STYLES

NAVIGATOR | =

We can now use the Inspector to edit the body style. The Inspector will edit whatever object we

happen to have selected,
but we can make sure we
are editing the correct
element by checking what
the Inspector states in the

title bar.

Select the ‘Fill’ area of the
Inspector to display all the

‘Fill’ related attributes.

Step 4

We want setup a
background image, so click
the ‘background-image’
item.

When it’s clicked, it will

expand. If an item is

expanded, it means that it

CONTAI

Flux QuickStart Guide

6 Simple
Q Advanced

=] Borders
ATTRIBUTES

POSITION

position

x ' bottom
= Position & Size 3
| right
O Fin
=] Margins & Padding width
|=] Borders et
A et OTHER
_ min-height
:= Tables & Lists i
max-height
& WebKit min-width
i:_‘fj e max-width
z-index
<= Other Parameters

12




is enabled, although it doesn’t have a value assigned to it.

Flux QuickStart Guide

The easiest way to assign a value, i.e. the name of the image, is to click the little downward

pointed arrow, and choose an image from your project.

background-color

iimple :

opacity
\dvanced background-attachment
lorders nd-image
IBUTES

round-position-x

ckground-position-y
background-repeat

background-size

'osition & Size

Aargins & Padding

lorders

“

Step 4

At the moment, there are no images in
you project, so see the ‘Adding Assets to

your Project’ section of this guide.

If you want to use the same images as we
use in this guide, you can download them

from http://www.theescapers.com/

tutorial_images.zip To prevent

duplication of effort, we recommend you
copy all the images in this archive to
your project, as the others will be used

later in this guide.

Choose the appropriate image from the pop-up menu, in this case ‘wallpaper.jpeg’.

[ ls) = Inspector - CSS Style - body

IGN
background-color

R  background-postin

Margins & Padding background-position-x
back d-position-
Borders ackground-position-y
background-repeat
Text background-size

Tables & Lists
WebKit
Misc

Other Parameters

Simple
opacity
Advanced background-attachment
Borders background-image
‘RIBUTES inherit »
Position & Size ( none ) ( inherit )

ASSETS

2.png
- 45k

T T | b:ok_now.png
= 1

book_now_hover.png
_ 2k

flower.jpg

Bl -«

wallpaper.jpeg

The image should immediately appear as the background of the page.

13
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The Inspector

Almost all parameters are changed via the Inspector, for both CSS rules and elements on the
page.
The Inspector, amongst other things, controls the

properties of CSS Styles, both external and inline.

Qu Ic k ¢ h anges w]u« Assistant Controls

Remove Inline Styles
Many common configuration options can be QUICK SETUP

accomplished via the ‘Gear’ menu on the
Dotted black Border
Dotted white Border

lot of time by populating many property values at No Border (Remove)
No Border (Declare)

CONTRIBUTORS

body
Enabling properties v T

Inspector. These ‘Quick Setup’ entries, can save a

once.

Before you can setup, say, the color property of a

style, you need to first enable it. This is done by

simply clicking on the disabled property.

|75 2NNV /= O\

Inspector - body
TEXT
color

letter-spacina

texteigan color : Sets the color of text, i.e. 'red',
|#£0000, or rgb(255,0,0) \

text-shadow

text-decoration
text-align

After being clicked, the property will expand to reveal options concerning it’s value, in this case

there is a color well for picking a color via the standard Mac OS X color picker. There is also a

text field where a color can be manually typed in i.e. rgb(255,0,0) or #££0000

TEXT . b

color x

~

. | 000000 v
Document Colors
-
Giant Coldfish

letter-spacing
text-indent

14



Disabling properties

Flux QuickStart Guide

When you want to remove a property, press the little ‘x’ button, this will remove the property and

it’s value from the selected style or element.

color

I | 000000

Document Colors
m

Toolbar

The most important area of the Inspector toolbar is pinpointed by the red arrows, these items

indicate what the Inspector is editing at that time, it’s very important you don’t accidentally edit

the wrong style or element, so always keep an eye on these items.

728x90

[ A5k, Jun U1 201U 15:19:41 I

2oS

| DOCL

Inspector - body

DESIGN

6 Simple color
mm | Advanced | | #000000

The blue arrow points out the ‘Gear’ menu, where useful options are held.

The orange arrow points out the ‘+’ button, this button allows you to enter a property manually.

Side Bar

Styles and elements, have hundreds of possible options, so they have
been split into sections to allow them to be easily found. These
sections are split into two groups, the first, pinpointed with the blue
arrow in the image to the right, is the ‘Design’ group, these sections
are easy to use configurations, where you can visually alter styles.
The second group, pointed out by the red arrow, contains all the
options, and they can be modified individually and accurately.

The third group, pointed out by the orange arrow is quite different
from the other two, as it only appears when you are editing elements

and not styles.

The Contributors section lists the styles that an element is linked
to, i.e. styles that contribute to how an element looks and behaves.

You can click on these contributor styles to make them editable in

the Inspector.

15

|

DESIGN J
6 Simple colo
@ Advanced E
Docu
=1 Borders /i
ATTRIBUTES Gianj
2 Autributes & Actions (1) |
[ rosition &Size lette
: text-
O Ffil i
(=) Margins & Padding text-
=1 Borders fext
e | 11NE
7 Text (1) text-
.= Tables & Lists whit
® webk | FON
=| Misc il
= Mi
= font:
< Other Parameters font-
CONTRIBUTORS font-
Cc» "
font:
| INTH




Attributes & Actions

Flux QuickStart Guide

Like the Contributors sections, the Attributes & Actions section only applies to elements, not

styles.
In this section, you can view, [ ﬂw&f; ’\\e SV“ UM V=
. F' \ A k[ ‘sﬂ &' \& /.
edit, and create new R ~as > S .- BT a” "5‘
Inspector - body ’é
attributes in an element. : 5%
STANDARD
An attribute is, for example, | id
class
t h e
href="www.apple.com” F!‘ background-image: url(file:// /Users /mt/Desktop/ ACTIONS
. onSubmit
in a <a> tag, or the onSelect
. . Reset
1 ="m le” in a div. on
cLass ystyle onUnload
You can easily add attributes onLoad
onKeyUp
using the small ‘Gear’ button onKeyPress
. — onKeyDown
under the attributes table, ® e
there are many preset anbiCReK
onChange
options, including Zope onBlur
. A onClick
specific attributes. onMomsatver
To remove an attribute, onMouseDown
simply press the small ‘x’
buttons next to the attribute.
You can press the small ‘i’ button to view or edit the attribute in a much larger editor, which is

useful for attributes with long values.

Inline and External styles

It’s very important to understand that the Inspector can edit both inline styles and external ones,

and the Inspector has indicators to tell them apart.

The colors of these indicators are configurable in the Preferences.

16
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Adding an object to the page

Before you add any object to the page, you need to first select the parent object that you want to

insert the object into. The first object you create will have the body object as it’s parent, the body

object can be considered to be the root object.

CONTAINERS v FORM

Step 1 -

Select the parent, in this case, it’'s the body element, so

you can click almost anywhere on the page to select it.

Step 2

Once the element is selected, we need to add a new

div, a div can be considered to simply be a container

for objects, than can be decorated as you see fit. Use

the Quick Div option, as this type of div comes pre-configured with certain values that make

them easier to work with.

T L, I ———

The Containers menu has a lot of different type

of objects to choose from, the differences are

explained in the Flux Reference Manual, which is

available from the Help menu.

Step 3

% Floating Quick Div
Empty Div

Once you have created the new div, select it by

clicking on it, and we can start configuring it. Empty Divwith bordér

Empty Div with absolute position and border

The image below shows the new div is selected on [ o 4

h FRAMES ; ﬂ

the page. Empty IFrame t..
CANVASES =N

Fmntv lavascrint Canvas

17



Step 4

Flux QuickStart Guide

We want this object to become the main container on the page, and for it to float in the center.

We will first set the

size of the object, we
want it to be 600 px

(pixels) width, and

DESIGN

500px tall. 4 @ simple position &%) X
A () Advanced \2bsol 2
Make sure the object is [ sorders ﬂl‘m
cill lected d ATTRIBUTES St
sti selecte an . >
’ ¢ Attributes & Actions (1) top €5 okl
iti e — 100 px $
choose the Position TR S
& Size section of the O il left (553 X
90 | px :
Inspector. Margins & Padding
bottom
See how there are 3 Borders right
Text SIZE
already values A -
.= Tables & Lists :
. . = dth x
populated, this is _ et =
&) WebKit 600 | px :
because we created a B Misc

=l

Quick Div which
creates a div with some

values already

<= Other Parameters

T
Inspector - div

POSITION

min-height

max=heinht

configured.

Change the width value
to 600 and the height value to 500.

immediately.

You will see the selected object on the page change

Note :At the top of the Inspector sections, you will see the word Inline, this means the values are

being made directly to the element on the page,and NOT via an external style, don’t worry about

this, we will make it into an external style later.

Step 5

Now, we will change the color of the element, so we need to switch to the Fill area of the

Inspector, and enable the background-color attribute.

18
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Once, the background-color

attribute is enabled, click L —
the color well and choose background-color
the color you want the () Advanced (L) '#DBDEDB
_ Document Colors

container to be. Borders il

| Giant Goldfish
You can choose any color 3B seliiinicha

: <2 Attributes & Actions (1) - m
you like, but for this Fo o

design, we recommend a

a [ .
; [ Position & Size (5) opacity
A — background-attachment

light grey. Again, you will
see the change happen

immediately, and the element will be much easier to see on the page.
Step 6

The last step of this section is to put the container in the right place. At the moment, it’s on the
page, in a fixed location, we want to make it centered.

Flux makes centering object

very easy, with the element still | _ 7| TEXTRNN| MISC Y| FACKAGES v NN B
Inspector - div PN A
selected on the page, choose QA
+ % ¥ Use Assistant Controls
Auto Center from the Gear = Remove Inline Styles
e o]
. ADD ATTRIBUTE
menu at the top right of the
P 8 background-color background-attachment
Inspector. (L) [#DBDBDSB background-color
Document Colors background-image | 2
You will see the object move to | background-position
Giant Goldfish background-position-x
a different position straight | o background-position-y
background-repeat
away, although it may not be o background-size
= background-attachment opacity
centered, this is because the [ background-image QUICK SETUP
: T
element may still have left Rk . e
. . . background-position-y Dotted white Border
value assigned, if it does, gl et o Boder R
remove it by switching to the background-size N ord e

CONTRIBUTORS
Position & Size section of

the Inspector and clicking the
little ‘x’ next to the left value.

You can also set the top value to a different value, around 100 would probably be about right.

19
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80O |«| Page Editor - MySite/index.htm| —)
: ‘ = b= d Preview | Live Preview v |
index.htmi
STYLES | NAVIGATOR | = [ CONTAINERS ¥ I FORMS v I PACKAGES v ] h oo
© main.css 2 ..'0. 3 .o... ....’ o,
: '
.mystyle & ot ¥, L v :
KN ELNE.
C.\ o e < /=
p Q A /2 A
ik
7
\
0
Y,
- n
RS \ : oA Y A - 5 L 54 1A
[ frames L Padding L Margins L Spans L Tokens I Relations L Grid L Masters ] (100% 7))

Your page should now look like the image display above. If you cannot see the blue margin areas,

check that the “Margins” button at the bottom of the window is clicked on.

20
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Creating the external style

The element we have just created has the CSS styling embedded inline, this is generally considered

undesirable, and it’s better that styles are external.

In this section of the guide we are to convert inline styles into external styles.
Step 1

Make sure the element we have just created is still selected, and choose Create Style with...
from the Edit menu.
Enter a name for your new external style, in this case, we will call it ‘mycontent’.

Choose the stylesheet to save

the style in’ in our examp|e’ (¥ raye Cuilul = viysIite/ imnusx. i
- = o=
there is only one StyleSheet — =] fef 1 —C
ts Master Elements. Page Code Layouts

attached to our page, so we

y 7 A new style will be created using the selected object as a template, the style —_
don’t need to choose. l CON  will then be applied to the selected object. v

Optionally, all inline styles can be removed from the selected object. , ]
We also need to choose if we ?ﬁ“
CsSS

want to create the external

Name
style as an ID style or a Class ' mycontent
style. In this case, choose ID. StyleSheets
. . [ file: i in. S
Lastly, we need to decide if we file:///Users/mt/Desktop/MySite/main.css ¥ ]

Setup Style as
®D
() Class

want Flux to remove the inline
styles in the selected object,
in this case, we do, so make

sure this option is checked. E]Remove inline styles from source object

Step 2
( Cancel ) (Ol

After performing this
operation, the page shouldn’t
change at all, but a new style | |
will be visible in the Style List, [ —— — -—
called ‘#mycontent’, the ‘#’ sign means it is an ID style. Media Inspector Actions & Widgets Snippets
Flux has also ‘linked’ the external style to the page element f iadex ok ]
by setting the ID attribute in the page element. i STYLES =

) main.css °

(R #mycontent IV

i

21
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Editing the #mycontent style

Now we have created the external style, we can make a few changes to it.
Step 1

Select the #mycontent style in the styles list and open

the |nspector VIEUId  ITISPECUT - ALLIONS & WIUYELS Smippers 1

Let’s alter the border of this style, by choosing J index.html* ]
Borders under the Design section of the STYLES - [
Inspector. ) main.css °

#mycontent D

.. 0
I‘. v-e'..‘ =

Step 2

.mystyle

Make sure you are editing the external style by

checking the Inspector at the two locations

pinpointed by the red arrows in the image below.

Select the ‘All sides’ option, as we want the change the border on all the sides of the element.

’ A A ’m , ‘ m\ ““’V‘-’ ’m , ‘ m

\n*;l ‘ ‘ ‘A*l’ ﬁ

Inspector - CSS Stylg - #mycontent

BORDERS

e Simple

'\:/ Advanced

orde!
ATTRIBUTES
[E Position &Size (5) O e
O Fin

Margins & Padding (2)

=] Borders O

£ Text e All sides ( Remove Borders J

:= Tables & Lists E
@ Webkit Style | solid

e (1 Color E]

</ Other Parameters Width -2—@

Change the style to ‘solid’, pick an appropriate color, and set the width to 2px.

Changes will happen immediately.
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Preview your page

We’ve make quite a few changes, so now would be a good time to preview your page, Flux can

preview your page in two different ways.

Method 1

Choose a web browser installed on your system from the Preview submenu, which is found in

the Page menu. You may need to

use Update option before any

ZGEN Arrange  Font

View Window Plug-ins Help

browsers appear in this list. Preview

Once you choose the browser,
. ) Insert Object
your page will be opened in that Delete
browser. Zoom Text In

Your page and stylesheets will be Zoom Text Out

Zoom Page In
Zoom Page Out

automatically saved before the

preview. Actual Size
Page Attributes...
ain.c
Method 2
Another method of previewing, is s

to use Flux’s built-in web browser,

to do this, simply press the middle

Edit in External Editor

iges
@ Firefox Xl C

> @ Google Chrome 32 ="

X $8E

¥
l iPhoney 83 [
#+
- @OmniWeb X 884
N8+ <
3 Q Opera 85
Nl &) safari [ xx6

w Stainless X7
] un}g Validator-SAC 88

{ WebKit X 39

[ RFCTATE

section of the button bank at the

top right of the Page Designer window.
Your page and stylesheets will be
automatically saved before the preview.
Flux’s built-in Preview function is very

similar to the Apple Safari web browser

—

Live Preview v

supplied with your Mac.

Once you have finished previewing, press
the ‘Edit’ section of the button back to

return to editing your page.

R % YU

It's recommended that you preview your page in a few different browsers, particularly Firefox, as

many web users use this browser.
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Locking objects

We’'re finished editing our new object now, so to prevent accidental editing, we can lock the object.

To lock the object, make sure the

object is selected, and choose
Toggle Lock from the Edit
menu, or use the shortcut
Command-L.

You won’t be able to edit this
object visually until you unlock it
using the same method, although
you can still edit the object using
the Inspector and the Code
Editor.

Locked objects are visually
recognizable as their tags turn
red, and the drag handles for

resizing are disabled and grey.

Page Arrange Font View Window Plug-in
Undo ®Z ) Flu
Redo 0¥z '
Cut 32X ictions  Text Box ¢
Copy $C feguar 3] [10
Paste ®BV |
Paste in location >
Paste As Plain Text {8V
Paste Rich text as HTML ~BV

Paste as Image from Clipboard {4V
Delete & |
Duplicate #D
Select All #A

Select None O ¥A

Finish editing inside current Tag >

Spelling >
Find >
Format >

div D mijed

-: \ ~N g / -*- 0..:::0
A= % d ..”o.
) A S
- - , = . ‘
AT neantant e N
74 '
* g
L
y W
L\,\)‘I
[
B
|\
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Creating another new object

In this part of the guide, we are going to create the bottom bar part of the website, where we can

write copyright information.

B

Before we create our next - [CONT“NHS P~
- v v
Obl eCt’ make sure yo u have Hold Shift Key to use external styles.
selected the object that is |[pv ) S
. - . o ¢ o 3
intended to be it’s parent, i.e. <, % Quick Div N ®C

the object we have just

Empty Div
Empty Div with border

created. This is very
Empty Div with absolute position and border

important, if we select the FRAMES

wrong parent, the structure of Empty IFrame

. . CANVASES

our page will be incorrect. _
Empty Javascript Canvas

Our next object is going to be

TABLES
. . ick Tabl C
a floating div, so choose e ey LT
Basic Table with heading
Floating Quick Div from Table Cell
. Table Head
the Containers menu.
Table Row

You will see the object appear -
at the top left of the large grey
element we created in the previous section. If it appears in the top left of the body element

instead, then delete it, and try again, making sure you have the correct parent object selected.

Step 2

Click and hold the mouse button on the bottom right
drag handle of the object, and drag the object to roughly
the desired size, it’s width should equal that of the
parent element, and it’s height should be about the
width of a ballpoint pen. We can adjust it more

accurately in the Inspector later, this is just an

exercise to get used to using drag handles to resize an

object.

Step 3 L

Once you have dragged the object to roughly the correct size, use the Inspector to set the color

to a dark grey color.

25



Flux QuickStart Guide

Step 4

Inspector - div

ATTRIBUTES

+ 4
DESIGN =
6 Simple background-color
) Advanced [____] #4B4B48B 0 Y
) Doc\%ment Colors e &/ : Colors
Borders | background-color : Sets the background color "

Giarof an element, i.e. 'red’, #ff0000, or rgb
I(ZSS 0,0)

42 Attributes & Actions (1)

[ Position & Size (3) opacity

(1)

background-attachment

-position
-position-x

background-
[=] Margins & Padding background
Borders background

background-
B Tave . “ a

image

position-y

_

Next, we need to make the object hug the bottom of it’s parent element.

To do this, switch to
the Position &
Size section of the
Inspector, change
the Position to

absolute, enabled the

bottom and set it to
Opx.

Step 5

Since we just used

the drag handles to
get it roughly the
correct size, we can
get exactly correct
the

now using

Inspector.

o 1~ SR O AN A B /AR N Y 1~ SR OAN A B /A R

Inspector -

DESIGN position (&3]

6 Snie absolute
float

() Advanced e

Borders top

ATTRIBUTES left

¢ Attributes & Actions (1)

=~ e
|_padding L Margins L spans L Tokens L Relations _J

) Fill
(=) Margins & Padding
Borders

ﬂ Text

:= Tables & Lists

@ Webkit

Misc
min-height
max-height
min-width

<= Other Parameters

Set the width to 100 and set the width unit to ‘%’, this will make the object 100% of the size of it’s

parent, i.e. exactly the same width.

Step 6

Like before, we have been making these changes inline, and now we want to make them external.

So, just like we’ve done before, make sure the element we have just created is still selected, and

choose Create Style with... from the Edit menu.
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This time, we will call the style ‘bottombar’, and again, it will be an ID style.

It’s important you carry out this last step, or the rest of the tutorial will not work correctly.
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Entering text into an element

The element we just created is intended to display copyright information, so lets enter some now.
Step 1

Switch to Text mode by pressing the button pictured below.

“ Preview Live Preview V]

Step 2

Click inside the bottom bar we have just created.

It may be difficult to see, but a flashing cursor

should appear where you can start typing.

Step 3

Enter your text, for this example, we will enter

‘Copyright The Escapers 2009’

Step 4

Switch back to Edit mode to complete the text

changes. Save the document by _ .

pressed Command-S.
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Text styling

The text we’ve just entered doesn’t look very pretty, the alignment is wrong, the color is wrong

and it needs to be moved down inside the object.

First, lets tackle the color.

Step 1
f index.html ]
To correct the STYLES - Inspector - C
color, we need to z
) main.css
edit the #bottombar
style that we color
created earlier. 2 letter-spacing
_ ; Advanced text-indent
Select the style in Borders Sl
the Styles list and ATTRIBUTES text-decoratio
text-align
open the Position & Size (4
p | E SR 6 S2e s line-height
Inspector to the O Fill (1) text-transforn
Text section. =) Margins & Padding white-space
. : FONTS
Making sure you are 4 [E] Borders -
editing the correct o
g font-family
style by checking .= Tables & Lists font-weight
the top of the B Wahit font-style

Inspector (check

the correct style is being edited, it’s pinpointed by the blue arrow in the picture to the right)

Step 2

Enable the color attribute by clicking on 106 Inspector - CSS Style - #bottombar

it, and use the colorwell to select an

appropriate color, maybe white, or a

light grey.

color

D Simple [ 3
letter-spacina®
. Advanced text-indent color : Sets the color of te:

As with the other attribute changes, you |#ffoooo. or rgb(255,0,0)

A Borders text-shadow
ITRIBUTES text-decoration

= - y text-align
L Position & Size (4) AT
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will see this take

La’ls&
Inspector ~ CSS Style - #bottombar
000

Q|5

effect right away.

Step 3

DESIGN

We’ve corrected @ simple olor Q ‘—
the color, so now () Advanced (L) | #FCFFFF
Docgm»eﬁrr\tWColors
let’s take care of : A yyright The Escapers 2009 ET:;:::S C-iansfloldﬁsh.
the alignment. P ETTD TS G G ( 18 Position 45ize () u__u.
Alignment is done 3 mnm letter-spacing
in the same place
in the Inspector.
This time, enable the text-align property, and set it to
‘center’. text-decoration

Your text should now look similar to the picture - text-align A

. line-height D
below, both the color and the alignment are now 9

text-transform
correct. white-spiace
It’s important to realize that these changes are being FONTS
made to the CSS style, and not the element, the e

element is linked to the style.

Step 4 i Position & Size (4) A
O Fill (1) letter-spacing
text-indent
Next, we need to change B Margins & Padding e
he font size, so enable the S
the ’ Borders text-decoration
change to 9px. = Tables & Lists (EJZ2]|=E]E ‘
& WebKit line-height
é] Misc text-transform
) white-space
<= Other Parameters
font
font-family
font-weiaht
font-weight
font-style
font-size X
| -
9} | px d
font-stretch
e e e ™ ————————————— ]
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Padding

At the moment, the text of our bottom bar is at the top of the element, it would probably look a
lot nicer if it was pushed down a little more towards the centre of it’s container.

A good way to achieve this, would be to use padding. Padding is like the inner margin of an
element, for example, if you had a container div with a paragraph of text within it, and you set a

Icm top padding, the text would start flowing Icm from the top of the div.

NN = SN S TN

|
L J

The purple handles in the image above are the padding handles, they may be a different color on

your Mac, but they are always the inner handles.

Step 1

Click and hold the mouse button on the top padding handle, you can visually adjust it, but first you

will be asked if you want to make the padding inline or external.

Q “ Preview I Live Previe

The property '‘padding-top' is not setup in either the inline or
a linked external style, where would you like to set it up?

As a guide, if you plan on using this style more than once, put it in an external
style. If you are overriding a style as a 'one-off' then the inline style may be
more appropriate.

. |

#bottombar in main.css

( Cancel ) ( Put it Inline ) ( Put it in selected style )

A Text

Make sure the #bottombar style is selected, and press the ‘Put it in selected style’ button.
Now you have chosen where to store the padding changes, you can use this handle to tweak the

padding. There are a few important points to be aware of.
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a) The padding changes will affect all elements that are linked to #bottombar, unless overridden.
b) The overall size of the element will increase, this may seem a little odd, but this is how padding
is defined to work by the W3C.

c) The change you are making visually is explained at the bottom of the Flux window (See red

arrow).

=
“Botfombar LopX

e — |
----- - - -
Changing padding-top to 14px in #bottomba

1 |
—

We recommend you set the padding to around |0px.
Step 2

As we explained in note ‘b’, the overall size has increased, so we need to adjust the height of the

element to account for this.

Adjust the size by tweaking the bottom square handle to adjust the height, since this box is still

anchored to the bottom, only the height will change.

[_fFrames L Padding [ Margins ]

Uk

Again, the change you are making is explained at the bottom of the window.

We recommend changing the height to around 20px.

Once you have made these changes, use Command-L to lock the element.
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Creating a heading

Step 1

Create another ‘Floating Quick Div’ making sure to use the element selected in the image below as

the parent.

div | Dimticontent

It’s always very important to get the structure of your site correct, if you don't, it'll be difficult to rectify when

the page gets more complex.

Once you have created the new floating div, it should appear on your

page in the same location as the image to the right. If it does not,
delete the div and try, again, making sure you have selected the

correct element as the parent.

Step 2

For this element, we are going to make a style from scratch, so

create a new style by pressing the small ‘+’ button at the bottom of

the Style Lists, and choose New Style.

STYLESHEETS
. Add StyleSheet 4
*  Add Embedded StyleSheet
RULES
{v NewComment ish;
(v verride Style p ount
(N Pseudo Classes P
' CSSRules > ==
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A new style will be be created called ‘.newStyle’, we will rename this to something more
descriptive. Select the style in the list, and either right-click your mouse, or control-click, to
reveal the contextual menu.

Choose ‘Rename’ from the menu, and type in the new name.

In this case, we will call the todia | ctor Actions & Widgets Snippets Master Elements

new style ‘.topBar’ .
y P index.html

)

in the

The preceding

STYLES  NAVIGATOR | =

name, means it's a class

style, not an ID style like € main.css

we have been using so far. lm —
‘ 1 Delete...

#bottombar :
Step 3 ¢ Rename using panel...

| Rename —
~ Duplicate

Make sure the ‘.topBar’ is

selected in the Styles list

Select Objects using Style
Create Pseudo Style for selected Sty

and open the Inspector,

as usual check to make

sure you are editing the

correct object in the

Inspector by checking

the values pinpointed by the red arrows.

STYLES - NAVICATDHR E :

-' ) main.css o

Select the Fill section of the Inspector and enable the background-color property.
Set the color to the

same co | or as th e F BAR \ V7 77 Ral) [ I _ a\ANIS ** RAAFS/a _ LNy N

\ 8006 Inspector - CSS Style - .topbar

#bottombar style, the " topbar

easiest way to do this

DESIGN
is to use the color .
6 Simple background-color
picker feature of the @ Advanced (000000
Document Colors
Mac OS X color palette B Borders B =
(pictured below.) ATTRIBUTES Giant Goldfish
[ [ |

ﬁ Position & Size

An alternative solution w opacity

= = background-attachment
would be to setup a = Magins & facdag background-image

‘Swatch’ to keep track

34



Flux QuickStart Guide

of all your colours, in the screengrab, the ‘Giant Goldfish’ swatch is active.
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Step 4

You may have noticed that the changes you are making to this style are having no impact on the
look of the page, this is normal, and it’s simply because, although you have created the element,

and the style, we have not linked the two yet, so let’s do that now.

Make sure the floating

div you created earlier is

lected th .
selected on the page Add Element 10 Snippets...

Right-click (or control-
Insert text after selected element

Insert Div before selected element ! .
insert Div after selected element

click) to pop open the

contextual menu.

Attributes & Actions...

Toggle Lock

Delete selected element

Select parent element

Take element out of parent element
Put selected objects in new div
Create style with...

Choose the ‘.topbar’
style from the Set class
to... sub-menu.

You have now linked

the .topBar style to your

floating div, this means mystyle
the floating div will SetID to... g topbar
Select Element >
adopt it’s style from Edit Image in... >
MNoolale 1 lal.

the .topBar style. You

will see the floating div

change color immediately to the background-color you setup earlier.
Step 5 - Optional

To understand how the element is linked to the style, select the floating div, and select the

Attributes & Actions section of the Inspector.

NN W NN SN

Inspector - div

DESIGN

6 Simple

u Advanced

v position:relative ; width:100px ; height:100¢ 00

v topbar 00
=1 Borders

ATTRIBUTES ]

) Fin

[=] Margins & Padding

)
"

E ﬁ Position & Size (3)

Borders

You will see all the attributes of the element listed, the ‘style’ attribute is the inline styles, this
value is generated by Flux based on the options you have selected in the Inspector. The other

attribute is ‘class’ which is the value that is linking this element to the ‘.topBar’ style.
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Step 6

Now that the style is linked to the element, any changes we make to the style will be immediately

reflected on the element.

We will now set the width and height property of the style.

Select the .topBar style in the Styles List for editing in the Inspector, and select the Position

& Size section of the Inspector.

POSITION

position

T float
. Advanced clear
=1 Borders top
ATTRIBUTES left
bottom .

"= Position & Size (1)
€) Fine
[=] Margins & Padding
= Borders
A Text

- S m et

right

As always, make sure the Inspector is editing the correct object, in this case, the .topBar style.
Enable the width property,and set it to 100% as shown in the image to the right.

Enable the height property,and set it to 60px.

You will probably notice that the size of the element hasn’t changed, even though the style is

linked to it. Why? Because the element still has inline styles that are overriding the values in the

external style. Inline values always override external ones.
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We need to remove the

inline styles from the
element on the page, so
select the element on the
page, the

Inspector and use the

open
‘Gear’ menu to choose

the Remove Inline
Styles function.

When you have done this,
you will see the width and
height changes appear on
the page, as there are no
overriding styles now.
page should

look like the image below.

Your now

Flux QuickStart Guide

£33, o
Inspector - div

% ¥ Use Assistant Controls
; Remove Inline § s
QUICK SETUP ™
Auto Center

Dotted black Border
Dotted white Border
No Border (Remove)
No Border (Declare)
CONTRIBUTORS

.topbar

style v | position:relative ; width:100px ; height:100 Qt

class v | topbar [x] t

Copyright The Escapers 2009

RN, 26D

Now that the style is setup

correctly, you can use the drag handles to make the div bigger or

smaller, and the .topBar style will be modified automatically.

Step 7
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“ Preview Live Preview V]

Now, let’s enter some text into the heading

element.

S

Switch Flux into Text mode, by pressing the button

pointed out in the image on right.

You can now click inside the heading element, due

to the dark background, it may be difficult to see

the text caret, so look carefully.

You can now type in a heading, we’ve entered

‘Hotel Escape’, but of course, you can enter any text you want.

Once you have entered the text, we want to make it much bigger, so we will apply the HI style.
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Step 8

Select the text you have just entered (you need to stay in Text mode for this), by clicking and
dragging across the text, just
like you would in a word
processor or an email message.
When you have selected the
text like in the image to the
right, we will apply the HI tag

to the text.

Click in the ‘Text’ toolbar

button, and choose HI.

S s Span (span) By |
.;@v‘Am W Subscript (sub) %6‘
You Superscript (sup) S L
will Variable (var)
MEDIA A\ TEXT v | B
ED E see Break (br) -F
the | BLOCK STYLES 5
Paragraph (p) ‘
text H i
immediately increase in size, as the
‘ N 4
default properties of the HI tag include H2 |
H3
. ¢
a large font size. H4 i
- {
H6 N
HR |

L

You will also have noticed that your grey heading box has moved down the page a little bit, this is

due to other (unwanted) default properties of the HI tag, we will learn how to correct this in the

next chapter.
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Setting up the HI style

So far, we’ve setup class styles and id styles, now we are going to setup a different type of style,

often called an override style. It’s often called this because they override existing styles, like ‘HI’ or

‘b’.

Step 1

Our first job is to create the style,

Flux makes this

easy by listing almost all of the styles we can override,

so we simply need to choose it from a pop-up menu

(pictured right).

Once the new

index.html hl style has

STYLES i — been created,

) main.css ° I we need to

S change a few

’ properties in

- : the Inspector

h to make it look

e = the way we
| want.

Make sure the
hl style is selected (pictured left), and open the
Inspector.

As usual, double-check the Inspector is editing the

correct element by checking the toolbar.

Step 2

The first properties we will define in the hl style will

be the margin-top and margin-bottom properties. It’s

these properties that are causing the empty gap at the

top of the main container.

41
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index.htm!
STYLES -
) main.css
]
CCID B
CD 5 5
body p~
div :
[ od
ul ? 2
ol >
dl y g
SPANS t .
a ; k 1
abbr
acronym
b
blink
cite
code
dd
del
dfn
em
i
STYLESHEETS :fbd
1
Add StyleSheet >
4 samp
Add Embedded StyleSheet
span
RULES strong
New Style sub
{ New Comment sup
[{  Override Style » tt
( D = z
| P do Classes u
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To define these properties, select the Margins & Padding section of the Inspector, and

enable, and set both

properties to Opx. 'A 5,6!(?'%\1{0}-‘/&‘!\\‘&“ﬁzyf’.&\!&‘l&n\\ﬂ“f |

Inspector - CSS Style - hl

You will immediately see TRRETE pre—

DESIGN
the unwanted gap = iRin
@ simple
. L = =
disappear, this is because @ rdvanced margin-top . |
pXx H

the HI style (and almost

=] Borders /
T X
all others) have default ATTRIBUTES margnobottan : |
e : 0 X +
values. To make matters [5 Position &size - — — o) LB
‘:) Fill margin-right

more complicated, margin-left

different web browsers

have different defaults!

The are CSS packages that ‘reset’ these default values such as BluePrint, these packages are fully compatible

with Flux, and are worth investigating for more complex sites.

Step 3

Now, lets set the color. Making sure the Inspector is still editing the HI style, switch to the

Text section, and enable the color property.

As we have done before, use the color well to set the color to white.

> BN < SO\GNI/E BN < T\

nutel Escape

LY

Your heading should now look like the image above.

Step 4

We also need to move the text downwards, and to the right to make it look a little better.
We could make these changes in the Inspector, but for a learning exercise, we will use the on

page controls.
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Switch to Edit mode, by pressing the button | s ] J
pictured to the right. ‘Mode

Make the ‘HI’ element selected by clicking on it.

You can tell which is the selected element as it’s
handles will be available for use.

To alter the padding, drag the handles pointed to
by the red arrows, note, your handles may be a

different color. Let’s start with the top handle.

As you have not set these properties before, a dialog will appear to ask you where you want to save
them.

In the list, you will see your H/I style, choose this location, and press ‘Put it in selected style’.

»
l Lo o k0 SRS, P

The propergy 'padding-top' is)not setup in either the inline or
a linked exterie ; e would you like to set it up?

As a guide, if you plan on using this style more than once, put it in an external
style. If you are overriding a style as a 'one-off' then the inline style may be
more appropriate. ‘

This element has no attrit

Repeat the process for the left handle, set both to around 10px. The indicator pictured below will

assist you in setting the correct value.
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1 IR
| - Z . npvright L
Changing padding-top to 10px in h

Your heading should now look something like the image below.

e AN

tel Escape
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Create a subheading

We will now make a subheading, under the main heading, you could use an almost identical

technique to the main heading, but as a learning exercise, we will do a little differently.

Step 1

Select the HI element and press Command-C to copy it to the clipboard.

Step 2

Select the containing element (the dark gray box, pictured below)

Step 3

We need to now change the element we have just pasted. We will make the changes in the Code

Editor, press Command-3 to open it.
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HTML » BODY » DIV + DIV » H1

<h1>Hotel Escape</h1>

The Code Editor will display the underlying HTML code of any object you select on the page.
To try it out, select the second of the two ‘Hotel Escape’ elements, and change the tags so it looks

like the image below.

HTML + BODY » DIV » DIV + H1

<h2>Hotel Escape</h2>
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As you change the HI tags to become H2 tags, you will see the page change, the text will look

different,as our H/ style is no longer taking effect. We need to create a H2 style.

Step 4

To create the H2 style, we will

duplicate the HI style. To do this,

simply select the HI style in the index.html* ]

Styles List and choose Duplicate

-
(=]

STYLES : NAVIGATOR : = [ CONTAINERS v

from the contextual menu.

Then, simply rename the style as we ©Q main.css

have done before, change the name Delete...
from hl to h2. . Rename using panel...
Rename
Duplical
You will see the second ‘Hotel plica s

Escape’ element on the page change . Select Objects using Style

size and turn white. Create Pseudo Style for seleced Style

It has become white, as it’s now

adopting it’s style from our newly
created h2 style.
It has shrunk in size because the default style of a H2 element is smaller than the default size of a

HI element.

& SO b
iy b=

Inspector - S - h2

index.htm|* I

STYLES : NAVIGATOR | =

color

[ || #FCFFFF

Document Colors
o
H n

Giant Goldfish

B .

letter-spacing
text-indent
text-shadow
text-decoration
text-align
line-height
text-transform
i@ WebKit white-space
font
font-family
font-weight
font-style

main.css °

color : Sets the color of text, i.e. 'red’,
#ff0000, or rgb(255,0,0)

<= Other Parameters

font-size

font-stretch
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Using the Inspector, change the font-size property of the h2 style to an appropriate side,

somewhere between |12px and |6px (see image above).

The heading should now look like the image below, so all we need to do now, is to change the

text, again, we will use the Code Editor.
Step 5

Select the bottom ‘Hotel Escape’
element, and open the Code Editor
(Command-3) if it is not already open.
Select the ‘Hotel Escape’ text and
replace it with ‘The most prestigious
address in London’, the change will be
applied to the page a few seconds after
you finish typing.

You might find, that the bottom line of
text doesn’t quite fit on the dark gray
box.

If this is the case, select the gray box,
and use the bottom drag handle to

resize it.

You might find it difficult to 9N
select this element, as it’s L N
covered by the elements on BODY » DIV |
top of it. To select it, select

one the covering elements,

which are children of the

grey box, and use the

Select Parent Element

function in the contextual

-
.

 BODY » DIV » DIV » H2

<h2>Hotel Escape</h2>

DIV » H2

<h2>The most prestigious address in Londonj/h2>
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menu.

In complex websites, objects can

often overlap or obscure other Add Element to Snippets...

Insert text after selected element
Insert Div before selected element
Insert Div after selected element bec

ones, so take care to select the

correct object.You can also use
. Attributes & Actions...

the Navigator to help you select Toggle Lock -
. . . Delete selected element

the right object. i
. Take element out of parent element

Put selected objects in new div

Create style with...

Set class to... B
Set ID to... >
Select Element >

You should now have a heading

that looks something like the image below.

N W/—g %2 NG/ AN
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Adding an image to the page

Much earlier in this guide, we added some images to the project, and used one of them for the

‘wallpaper’ of our page. Now, we’re going to use another one of these images.

Step 1

Select the main container on the page (large, centered, light gray box), and add a Quick Div.

& ka

ts Snippets Master Elements.

R = [connmnsv FORMS v| MEDIA v

TEXT v

Hold Shift Key to use external styles.

Quick Div
w Floating Qui
Empty Div

Empty Div with border

X

cx Div

Empty Div with absolute position and border

Oitiotel = FRAMES i
- Empty IFrame address in London
R CANVASES

tel Escap...

Empty Javascript Canvas

TABLES

% Quick Table BT
Basic Table with heading
Table Cell
Table Head
Table Row

LISTS

w Quick Ordered list
Ordered nested List

% Quick Unordered List
Unordered nested List
Definition List

|
| —

This kind of div has some properties which have been preset to allow you to move it around an

resize it on the page. Resize it to make it a little bigger.
Step 2

Making sure the new div is selected, open the Inspector, switch to the Fill section, enable the

background-image property, and select the ‘flower.jpg’ image from the pop-up menu.
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Page Code Layouts Mode
Py FORMS v MEDIA v | TEXT v MISC v PACKAGES v | 3
00 - di
BV IOz AS T AN Inspector = div
IEEYE -
7
% -
~ “(&% O ¥ DESIGN
1) 12 i background-color
\%\V ‘/; < @ Simple
opacity
= S Ad d
n B ATSITEA & Advance background-attachment
E\ - Borders background-image X
I o | ATTRIBUTES inherit w
R ‘ ASSETS
N ; nioka Attributes & Actions (1) none ) ( inheri 2:png
- N [ Position & size (5) background-position ASK m
\" '3' ________________ ;i Fill (1 background-position-x book_now.png T i
=] Margins & Paddi background-position-y 1k
=l largins agaain +
i 9 < background-repeat book_now_hover.png LWL 2 TR
{ Borders background-size + By
é B Text = = ASC
= = Tables & Lists =N
& WebKit wallpaper.jpeg | W = wE
< 72k
) wic Y

= Other Parameters

The selected image will become the background of the div.

Step 3

You can now resize the image to whatever size you like, and position it wherever you want.

= 1
YT
A (/=
WA = &3
Ty

hZ

tel Escape

+ ue most prestigious address in Leandon

= s

To position the div more precisely, you can use the arrow keys on your keyboard to move elements

| pixel at a time, of course, you could also enter the co-ordinates manually using the Inspector.
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All the changes made in this chapter have been done inline, you could use the Create Style

with... function in the Edit menu to make it an external style if you want.
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Adding a text box

Step 1

Select the main container on the page (large, centered, light gray box), and add a Quick Div.

Move the new div to the desired location on the page, and resize it. See image below.

=)

Copyright The Escapers 2009

div I
(Y’Z L 2NNZE S O\ WY/ 2R

Step 2

Switch to Text Mode, and click inside the div. Enter the following text (or any other text you
like)

“Hotel Escape 1is the number one Dboutique hotel for discerning
travelers. Every room is equipped with a Bang and Olufsen television,
and a top-of-range Apple Macintosh computer with free internet

connectivity.”
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Once the text has been entered,
page should

image on the right.

your look like the

Step 3

Making sure the text box div is
selected, use the Create Style
with... function in the Edit menu
to make it an external style.

Call the style ‘bodytext’ and make
it a class style.

look a bit

To make this text

prettier, we will make some

changes to the .bodytext style we

have just created.

"Y' "lel Escape is ti.. number one

“and a top-of-range Apple

Flux QuickStart Guide

VAR

<N\ TR |

|
N

boutique hotel for discerning
travelers. Every room is equipped
;, ith a Bang and Olufsen television ;

Macintosh computer with free
internet connectivity.

MW@*—,&\:@? N\

= e ——— et b L R R

o

Copyright The Escapers 2009 X

Vo 2N = o\

Step 4
' - - - aa N — J—
om Inspector Media Colors Fonts| & O O Inspector - CSS Style - .bodytext
. Page Editor - MySite/ Stk + 3%
= o DEsion TEXT TEXTERNAL
5 Page Code| 0 Simple color
' Advanced PR || #484848 %
Document Colors
s v FORMS v MEDIA vl Borders [} m
B SV 1.9V A N AvAN -~~~ Whw | ATTRIBUTES Clant Goldiisb
EANYG \g X i : |
{ [ Position &Size (5)
g O Fill letter-spacing x
2 _* ~
| ] Margins & Padding 15 (px 3
Borders text-indent
text-shad
/2)
ik i text-decoration
:= Tables & Lists text-align X
@ WebKit 4 ELEZLE - Inherit |
= Misc
line-height x
= Other P: S — —
3 ” 15 | px T
text-transform
white-space
FONTS EXTERNAL
font
font-family x
Verdana =
| _4
&«
\:\| ml Escape s the number 5=
N | for discerning travelers. :
)ﬁ“ equipped with a Bang and Olu font-weight
‘{ and a top-of-range Apple Macl font-style
q ith f Int t tivity.
g\ w ree Internet connectivity oni e %
i' —4 10|‘ px .
{ font-stretch
~

Making sure .bodytext is selected in the Styles List and is being edited in the Inspector, setup

all the parameters in image above.

Try changing the values to see how they affect the display of the text.

54



Flux QuickStart Guide

Add a button

Our page is nearly complete, we just need to add a link to a new page, we will do this using
JavaScript and a couple of images to make a more interesting link than just some blue,underlined

text.
Step 1

Select the main container on the page (large, centered, light gray box), and add a Quick Div.

Move and resize the div so it looks like the image below, you don’t need to be exact.

m--Escape-fs--the--number--onr-bouti-cue
| for discerning travelers. Every room Is
equipped with a Bang and Olufsen television,
and a top-of-range Apple Macintosh computer
with free Internet connectivity.

Copyright The Escapers 2009

e e S It S ] D —

Step 2

Use the Create Style With function to create a style for the div, call it ‘booknowbutton’ and

make it a class style.
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Step 3

@'

.booknowbutton

DESIGN

6 Simple

_ Advanced

opacity

Borders

E‘AA“/&@&_&‘;%\;\& Q@iz A&’&é&_&”\\t R

background-color

background-attachment

Flux QuickStart Guide

~4
AT

Inspector - CSS Style - .booknowbutton

+ e

background-image X
ATTRIBUTES inherit | »
[ Position & Size (5) none W inherit

background-position

=] Margins & Pag€ing background-position-x
- background-position-

Borders e e .

background-repeat

B Text background-size

:— Tables & Lists

&) WebKit

= Misc

Select the .booknowbutton in the Style List and open the Inspector, as usual, check you are

editing the correct object.

Enable the background-image property, which is in the Fill section.

Choose the ‘book_now.png’ file from the pop-up menu.

You will see the image tiled across your div, to prevent the tiling, enable the background-repeat

property and set it to ‘no-repeat’.
Step 4

Your div should now look like the image
to the right, we can see that the div is a
little too big for the image, so use the
resize handles to resize it to around the

same size as the image.
Remember, if you want to put the button

somewhere else, simply pick it up and

move it.

Step 5

e boutique
‘fry room is
television,
h computer

To make this button a little more interesting, we are going to setup a pseudo-class.
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Pseudo Classes allow you to apply CSS styles when certain conditions are met, for example, you can

apply a pseudo class to make links that have been visited appear in a different color.

We are going to setup a hover pseudo style, which will apply a style when the mouse pointer is

‘hovering’ over our element.

Press the little ‘+’ button at the bottom of the Styles List.

Select the ‘.booknowbutton’ style in the Styles List, and

choose ‘hover’ from the Pseudo Classes submenu.

You will see that a new style has been created called

‘.booknowbutton:hover’

Step 6

At the moment, our new pseudo class has no properties, so it

won’t do anything, so let’s add a background-image property.

Select the ‘.booknowbutton:hover’ in the Styles List, and
enable it’s background-image property in the Inspector.
This time, select the ‘book_now_hover.png’ image in the pop

up menu.

Step 7

Switch to Preview Mode to examine your page, if you
move the mouse pointer over the the ‘Book Now’ button, the
pseudo class will be applied and the image will change to a

slightly darker variation.
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STYLESHEETS

Add StyleSheet
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Some older web browser do WY

not support all pseudo r one boutigue

*s. Every room

and Olufsen
will support the hover. -range Apple

free Internet ®

BOOK NOW

classes, but any modern one

It’s important to realize that

pseudo classes will ‘overlay’
their style onto the main
Copyright The Escapers 2009
class they are based on, so all s i

the other parameters like |

size, position, will still be
taken from the original

‘booknowbutton’ style.

ne boutique
Every room
nd Olufsen
inge Apple
ee Internet

Copyright The Escapers 2009
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Adding an action

We’ve created a button, so now we need to add an action to it to make it actually do something.
Step 1

Open the Actions palette by pressing the

«Actionss button on the main T00|bal‘. 3 lavic wiiaiw CUIInnc INFUI A

1 1

& $

Yo
Step 2

=

The Actions palette is used to attach Javascript ?J H

actions to elements on the page. We are going to o LS S L SppeE Sl
add one of the simplest actions. index.htm/* ]
STYLES | i = | col
Choose ‘Simple’ from the pop-up menu pinpointed : N
1ain.css o

by the red arrow.

Actions

~ =

Actions Widgets

{ Toolkit & Class
|

Simple
i

5

mport the required JavaScript files.

Redirect to page

Remember,

url | http://www.google.com

(&)

The URL of a page to redirect to

& N

@1‘; :

Attach To Selected Element ) on Event = onSubmit

—;\1"1 Ny__M )
: ‘ (e

°S @ . ;?,5
T .‘: ﬂ- .

window.location.href = 'http://www.google.com’;

Choose ‘Redirect to page’ from the pop-up menu pinpointed by the blue arrow.

The middle (main) area of the palette will change, this is where parameters for the actions are

set. This action only takes one parameter.
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In the ‘url’ parameter field, type an URL to redirect to, we only have one page in our site, so for

the sake of example, type another existing URL, i.e.

http://www.apple.com

or

http://www.google.com

Step 3

Select ‘onClick’ from the pop-up menu at the bottom

right of the Actions palette (see image, right). Le

Once you have checked all the parameters are correct, B
make sure the button on the page is selected, and press

the ‘Attach to selected element’ button.

This will attach the generated JavaScript code to the

‘ . ) r't‘.‘. "\ A If / ."'\}
onClick’ handler of the selected element. :-.my_.m.‘ >

Page Elements with actions attached will have markers

on them for easy identification.

Step 4

div
Switch to Preview Mode, click the mouse button on - 2K NOW
the ‘Book Now’ button, and the new page will load.

This make take a few seconds, like any other website.

Well done! You have just created a website using Flux!
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Create another new page and link to it

We’ve created a brand new page with images, CSS, and JavaScript. As one last task, we will create

another new, much simpler page and link to it.

Step 1

In the Site Manager, select the ‘Site’ folder by clicking on it’s title, and press the New Page

toolbar button.

image:
Jun 01 2010 15:19:31

index.html|
1k, Jun 03 2010 13:11:13

main.css
1k, Jun 03 2010 13:01:33

PE—
4 New Page b ges

2.png
45k, Jun 01 2010 15:19:31
728x90

book_now.png

1k, Jun 01 2010 14:33:20
138x35

book_now_hover.png
2k, Jun 01 2010 14:33:29
138x35

flower.jpg
131k, Jun 01 2010 14:33:29
500386

wallpaper.jpeg
72k, jun 01 2010 14:33:30
2024350

X seslueeee

NAME
MySite

DATE
Jun 01 2010 15:19:31

ITEMS
3

61



Flux QuickStart Guide

Step 2

Enter a filename for the new page.

Choose the appropriate type of page you want to create.

[new J

@ HTML i
i a .html extension, for simple pages with no embedded PHP, choose
1 this option. TREETE N
L O PHP

A new file with a .php extension, many webservers require this extension for PHP to

css operate.
O.ISP 10 15:19:31
A new file with a .jsp extension, this file extension is used by Java™ Application
Servers such as Apache Tomcat, Sun Java System Application Server, and JBoss. "
(O RHTML

— A new file with a .rhtml extension, for use with Ruby on Rails™, please note this file =
extension is now considered deprecated.

() .html.erb

.html.erb is now the recommended file extension for Rails projects.

() Empty File

DOCTYPE | XHTML 1.1 4]

e .o

In the sheet that appears, type a name for the new page, we will call it ‘new’.

There are a few options allowing you to choose what kind of page to create, choose the top one

to create a simple HTML file.

The last option is to choose what type of DOCTYPE to give your page. This can be changed later,

but it’s best to decide now.

In the image, we have chosen XHTML I.I, but ‘HTML 4.0l Transitional’ is probably the most

versatile, so if you are unsure, choose that one. Press OK.
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Step 3

Double-click the ‘new.html’ file to open it in the Page
Designer.

Using the skills you have learned in this guide, add some
objects to the page, it doesn’t matter what, as we are just

using this page as an example to link to.

When you have added some elements, save and close the
page.
You will see the thumbnail in the Site Manager update

to show your changes.
Step 4

Now, open the ‘index.html’ page, and switch into Text
Mode.

Select some text to make into a link, in this case, we have

selected the ‘room’ text.

Use the right mouse button (or Control-Click) to
open the contextual menu.

Choose Quick Link...

A sheet will appear allowing to either choose a

page to link to, or type one in.

In this case, we will choose a page from the pop-

up menu, the page ‘new.html’ that we just created.

Press OK and the link will have been

Flux QuickStart Guide

CUUIIDI JTT IVCW rayc

is equipped
television, and a
Macintosh computer
connectivity.

T

¥

images

index.html|

main.css

new.html

zscape Is the

with a

wumber one boutigue
hotel for discerning travelers. Every goom
Bang and Olursen
top-of-range
with free internet

Apple

Copyright The Escaper

= =
i i [ =] &od
created, you can switch to Preview Sieeses ke b
mode to try it out.
annd Create a link using a file from the list, or enter a remote URL such

as 'http:/ /www.apple.com'. l:
o

Ha
o«
&

@ Choose... | new.html

W
o~
DA

QType... http://www.mywebsite.com

s

e

Advanced

N
=0

target

name

L Cancel ) ( oK )
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The End

Thank you for reading this guide. If you have any ideas how we can improve this guide, or Flux

itself, please contact us@theescapers.com

To learn more about Flux, visit our user forum at http://www.theescapers.com/phpBB3
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